Minimum Requirements for the PC and Sound System

The minimum requirements to run TrueRTA are a PC with a Pentium III grade processor running at no less than 500 MHz with 64 MB RAM and full duplex 16 bit sound capability. (TrueRTA’s default calibration is for the popular Sound Blaster Audigy 2 sound card from Creative Labs, Inc.) Unlike most other software applications TrueRTA can easily demand every bit of processing power your computer can provide. For this reason it is recommended that you not have any other processor intensive applications running at the same time you are running TrueRTA.
Getting Started Quickly

Naturally, you will want to see your first audio spectrum as soon as you get TrueRTA installed. Here are step-by-step instructions to get you going quickly. NOTE: Because TrueRTA requires a lot of computing power it is best to have no other major application software running when you use TrueRTA.

1) Install the TrueRTA software.

2) Connect a multimedia microphone to the Mic input of your PC’s sound system. Or, you can use the microphone built in your computer.

3) Open the Windows Volume Control:
   - From the task bar, right click on Volume and select “Open Volume Controls”
   - Or, from the Start button select: Programs/Accessories/Entertainment/Volume Control.

4) Switch to the Recording Mixer:
   - From the Volume Control’s Options menu, select Properties.
   - At the Properties window’s “Adjust volume for” section, select “Recording”.
   - Click on the OK button to close the window to bring up the recording mixer.

5) Select the Mic input:
   - At the Record Control mixer, select the Microphone input.
   - Raise the Microphone volume slider to maximum and Exit the Recording Control.
   (If you hear the mic over the speakers then lower the speaker volume at the task bar.)

6) Launch the TrueRTA application software.

7) Under the Spectrum Analyzer menu, select RTA Mode.

8) Under the Spectrum Analyzer menu, select the resolution (1 Octave, 1/3 Octave etc.)

9) Press “Alt+Space” (the Alt key plus the Space Bar) to begin real time analysis. (Press “Alt+Space” again to stop)

You should now see a live spectrum on your screen. At the dialog bar on the right side of the screen try adjusting the Top and Bottom dB limits of the analyzer to get the view you wish to see. Also, try adjusting the High and Low frequency limits to see how they work.

Get a feel for the background noise and how it is displayed on the screen. Now, sing a note, and then stop the analyzer (Alt + Space) to freeze the display. You should see multiple peaks on the screen. If you happened to sing (or play) an “A” the left most frequency peak might be 220 Hz. It represents the fundamental tone of the musical “A” note. The 2\textsuperscript{nd} harmonic would be 440 Hz, the 3\textsuperscript{rd} harmonic would be 3 times the fundamental, or 660 Hz, and so on.

Switch to Oscilloscope mode (at either the toolbar or the Oscilloscope menu) so that you can view the input waveform in real time. Notice that the dialog bar at the right has changed to show you the Oscilloscope controls.

At the left side of the screen is the Generator dialog bar. Enter 200 in the Freq. field, select “Sine” in the Wave box and then press the On/Off button once to start the generator output and then a
second time to stop the output. You may not hear the 200 Hz wave if your audio is turned down. You will only see the 200 Hz tone at the Spectrum Analyzer or Scope if you have the appropriate input selected at the volume control’s Play Control mixer panel. (Double-click on the volume control in the Task Bar to open the Play Control mixer and select the “wave” signal for output)
Introducing TrueRTA

True Audio’s TrueRTA is a collection of real-time software-based instruments for testing and evaluating audio systems using a PC with basic sound input/output capability. The instruments found in TrueRTA include a low distortion signal generator, a digital level meter, a crest factor meter, a dual trace oscilloscope and a high-resolution real time analyzer. By creating these test instruments in software and employing the signal input and output capability of your PC’s sound card, we are able to offer a level of performance that could only be achieved by many thousands of dollars worth of traditional test instruments. In combination with your PC, TrueRTA provides a powerful audio testing capability, normally seen only in better audio research and design laboratories.
Entering your Registration Code

When you decide to upgrade to a more powerful version of TrueRTA you will be asked to enter a registration code along with your registration information. The registration information and registration code can be entered by selecting User Registration under the Help menu.

**Note:** because TrueRTA is a processing intensive program you will need to stop the audio input before entering your code. You will notice that many functions are disabled while the analyzer is running. When the analyzer is stopped TrueRTA is no longer using the CPU intensively and will idle in the background.

1) Look under the Help menu and select User Registration.

2) Fill in your name, title, company, address, city/state/zip and phone using the e-mail that was sent to you when you upgraded. Copy and paste it exactly as sent to you. Note that your user information is also a part of your registration code and must be entered exactly as supplied. For this reason we strongly recommend that you copy and paste your user information directly from your registration e-mail rather than enter it manually at the keyboard.

3) Copy and paste the registration code in the appropriate Level field.

You should now see the new level activated under the Spectrum Analyzer menu. You will need to restart TrueRTA in order to see the new level appear at the RTA resolution field in the Spectrum Analyzer dialog bar. Note that version 2 registration codes will not work with version 3 of TrueRTA. If your registration code appears to “not work” then you should carefully check that both the user information that you have entered as well as the actual registration code exactly match the information in your registration e-mail. Make a backup copy of your registration e-mail so that you will have it available in the future in case you upgrade your PC or have a hard drive failure. There is a service charge to regenerate lost registration codes…so BACKUP YOUR REGISTRATION!
Sampling Frequency Selection

Except for special situations, you will generally want to use the default input sampling frequency of 48 kHz. Only in special circumstances will you want to use a higher or lower sampling frequency. If the maximum input sampling frequency of your sound card is 44.1 kHz (the CD standard) then you will need to set the sampling frequency to that value for normal use. TrueRTA will remember your settings from session to session. If you need very high resolution in the lowest octaves you may want to set the sampling frequency down to 24 kHz or lower in order to get the highest possible resolution in the very low frequency range. The choices of input sampling frequencies are: 8, 11.025, 16, 22.05, 24, 32, 44.1, 48 and 96 kHz. The 96 kHz sampling frequency works with newer sound card to extend TrueRTA’s measurement capability to 48 kHz.

Output sampling frequency is selectable between 44.1, 48, and 96 kHz. Normally you will leave this set to 48 kHz. The 44.1 kHz output sampling frequency is only provided to assure compatibility with the widest possible range of sound cards. In order to perform measurements to 48 kHz you will need to set both the input and output sampling frequencies to 96 kHz.
Removing TrueRTA from your Computer

Should you need to, you can easily remove TrueRTA from your computer’s hard drive.

1) Go to the control panel and double click on the “Add/Remove Programs” icon.

2) When the Add/Remove dialog appears, locate TrueRTA in the list.

3) Select TrueRTA and then click on the Add/Remove button.

4) When you are asked “Are you sure you want to completely remove the selected application and all of its components?” select “Yes”.

TrueRTA will be removed from your computer.
The commands under the File menu are as follows:

**New** (Ctrl+N)

Clears all current data to create a new empty project file.

**Open…** (Ctrl+O)

Opens a **TrueRTA** project file (.rta) which you have previously saved to disc. Note that TrueRTA can be launched and a project (.rta) file opened from the desktop just by double-clicking on the file icon. Project files can also be opened by dragging and dropping the file onto the open application window.

**Save** (Ctrl+S)

Saves a **TrueRTA** project file to disc with the “.rta” filename extension. A single project file can contain up to 20 memories of data and notes in addition to the immediate data and notes on the Workbench. Project files also contain complete test setup information so that opening a saved project file restores the test setup that was in place when the project file was saved. This includes such settings as the dB and Frequency plot limits and the particular Mic Cal file in use. A total of over 50 measurement setup variables are saved within each project file.

**Save As…** (Ctrl+P)

Brings up a save file dialog which allows you to save the current project file under a different name or to a different location on your system.
Open Single Memory file to Workbench…

This command brings up an “open file” dialog which allows you to open a single memory (.rt1) file to the Workbench. This is useful for assembling reports using data from several different project files. Once on the Workbench the data can be saved to one of the 20 memories for inclusion in the project file. Test setup information is not included with single memory files. As a shortcut, you can drag and drop a single memory file onto the open application and it will be opened onto the workbench.

Save Workbench to Single Memory file …

Brings up a save file dialog which allows you to save the data and notes currently on the Workbench to a single memory file. Single memory files are saved with the “.rt1” filename extension. Use single memory files to create reports with data overlaid from any of your TrueRTA project files.

Print… (Ctrl+P)

Brings up a print dialog box and prints a report. In Analyzer mode the report includes all of the currently displayed memories. The report can be printed in either Portrait or Landscape mode. The use of color and other preferences can be set at the menu: Edit/ Preferences

Print Preview

Shows a picture of what the printed page will look like before you print the page.

Print Setup…

This command displays the printer setup dialog to allow you to select the printer, paper and page orientation. Printing in portrait orientation provides space for the most printed notes, while printing in landscape orientation provides a larger printed plot with less space for notes.

Export Data…

Exports the response on the workbench to a .txt file for further analysis or for use with other applications. Each frequency and its dB level are listed on a single line separated by tabs. The full frequency range from 10 Hz up to F(s)/2 is exported. Notes are not exported.

Import Data…

Opens a file dialog to select a .txt file containing data to be imported to the Workbench. Within the .txt file each data point must be on a single line in the format: “Frequency   dB” with the frequency and dB level separated by either a tab or spaces. When the file is opened the data is imported to the TrueRTA Workbench, interpolated via a powerful cubic spline routine and then plotted on the screen. Note that in order to move data between TrueRTA project files you should use the single memory open and save commands in order to transfer your notes as well as data. Comments are not allowed in the .txt file. A minimum of two data points are required. No control points are added to the data.

Exit (Ctrl+Q)

Exits the application.
Edit Menu

The commands under the Edit menu are as follows:

**Undo (Ctrl+Z)**

Undo is implemented for various text fields including the notes.

**Cut (Ctrl+X)**

Cut is implemented for various text fields including the notes. Text is cut and placed on the clipboard for pasting to another location if desired.

**Copy (Ctrl+C)**

Copy is implemented for various text fields including the notes. Copied text is placed on the clipboard for pasting to another location.

**Paste (Ctrl+V)**

Paste is implemented for various text fields including the notes. Use this command to paste in text that has been placed on the clipboard.

**Preferences**

This command opens the Preferences Dialog (shown below) where you can change various printing and display settings. The automatic generation on notes can be switched off as desired.
The commands under the View menu are as follows:

**Toolbar**

Select the Toolbar command to alternately hide or show the toolbar.

**Memory Bar**

The Memory Bar command alternately shows and hides the memory bar.

**Status Bar**

Select the Status Bar command to alternately hide or show the status bar at the bottom of the main page. The Status Bar displays information for menu items and buttons as well as showing the CPU usage and CPU speed setting that has been selected at the Edit menu.

*Note: You can keep the CPU usage meter running by parking the mouse over any button or control, otherwise it updates less frequently.*

**Generator Bar**

Alternately displays or hides the Generator Dialog Bar.

**Scope Bar**

Alternately displays or hides the Oscilloscope Dialog Bar.

**Spectrum Analyzer Bar**

Alternately displays or hides the Spectrum Analyzer Dialog Bar. By switching off the Generator and Analyzer Dialog Bars it is possible to let the plot window fill the entire screen.
Notes Bar

Alternately displays or hides the Notes Bar. Notes are automatically generated each time you stop the analyzer. The automatic notes record such information as the file name, date and time of the measurement, name of any mic cal file used, name of any House Curve file used, input and output sampling rates, FFT size and various other data.

In addition to the automatically generated notes you can enter your own notes either before or after the automatic notes. Notes are saved with each memory and with the project file. To edit a note for a measurement that you have already saved to a memory, first recall that memory. Then revise the note and save the memory once again. Note that there is a preference selection (see the Edit menu) to turn off the generation of automatic notes.

Grid in Front

Displays the grid in front of data on the main screen in order to facilitate reading precise signal levels. Normally the grid is displayed behind the data.

Background Color

Selects the background color for the main screen. The trace and grid colors also change with each background color. Choices are: Black, White, Green, Light Gray and Dark Gray.

Save to Memory

These commands cause the spectrum on the Workbench to be saved to the selected Memory.

From the keyboard, use Alt+1, Alt+2 etc. through Alt+0 to save to memories 1 through 10. Use Alt+Shift+1, 2 etc. through 0 to save to memories 10 through 20. For example, to save the current response to Memory 5 you would press and hold the Alt key and then press the 5 key.

Note: The most recently collected RTA spectrum is said to reside on the TrueRTA “Workbench.” This measurement is overwritten each time the analyzer is run, a response in memory is recalled or data is imported. Once you have measured a spectrum you want to keep (even temporarily) you save it to one of the 20 memories before proceeding with other measurements. All data in the 20 memories is saved with the TrueRTA project file. Data in the memories can be manipulated at any time by using the commands under the Utilities menu. Multiple memories can be overlaid to allow for easy comparison of various responses. While the analyzer is running only the Workbench and Memory 1 are displayed in order to conserve system resources. When the analyzer is stopped all selected memories are drawn.

Show/Hide Memory

These commands alternately show and hide the selected memory.

From the keyboard, use Ctrl+1, Ctrl+2 etc. through Ctrl+0 to show or hide memories 1 through 10. Use Ctrl+Shift+1, 2 etc. through 0 to show or hide memories 10 through 20. For example, to toggle the display of the response in Memory 5 you would press and hold the Ctrl key and then press the 5 key. Use Ctrl+W to toggle the display of the Workbench response. In addition to the menu and keyboard commands, you can also toggle each memory on or off at the Memory Toolbar.
Clear Memory

These commands erase the contents of the specified memory.

From the keyboard, use Ctrl+Alt+1, Ctrl+Alt+2 etc. through Ctrl+Alt+0 to delete the contents of memories 1 through 10. Use Ctrl+Alt+Shift+1, 2 etc. through 0 to clear memories 10 through 20. For example, to erase the response in Memory 5 you would press and hold the Ctrl and Alt keys and then press the 5 key.

Hide All Memories

This command turns off the display of all memories without affecting the contents of the memories.
The commands under the Generator menu are as follows:

**Generator On/Off**

Toggles the Generator on/off.

**Sine Wave**

Selecting this menu item sets the generator to produce a sine wave. Unlike the inexpensive signal generators frequently seen on audio test benches this digital signal generator produces a sine wave with very low distortion. Once you have performed the Line Output Calibration procedure the level of the output signal will be precisely the level you entered (in dBu) at the Amplitude Field of the Generator Bar. Specifying an amplitude of 0.0 dBu will result in a sine wave of the specified frequency with amplitude equal to 775 millivolts rms (0 dBu).

**Square Wave**

Sets the generator to produce a low distortion square wave at the specified amplitude.

**Triangle Wave**

Sets the generator to produce a low distortion triangle wave at the specified amplitude.

**Saw Tooth Wave**

Sets the generator to produce a low distortion saw tooth wave at the specified amplitude.

**Impulse Wave**

Sets the generator to produce a low distortion impulse wave at 10 dB below the specified amplitude.

**Pink Noise**

Selecting this menu item sets the generator to produce pink noise at the level specified in the Amplitude Field of the Generator Bar. Use the On/Off button on the Generator Bar to start and stop the pink noise output. Pink noise has a flat frequency response when the response is...
averaged using an RTA. Be careful not to set the generator level so high that you overdrive the pink noise as this will result in a non-flat response.

**White Noise**

Selecting this menu item sets the generator to produce white noise at the level specified in the Amplitude Field of the Generator Bar. Use the On/Off button on the Generator Bar to start and stop the white noise output. White noise has a frequency response that rises at a rate of 3 dB/octave when the response is averaged using an RTA. On a FFT analyzer white noise appears to have a flat response.

**Square Wave Duty Cycle**

Select this menu command to open a dialog box where you can set the duty cycle of the square wave. The normal value of duty cycle for a square wave is 50%. Note that a perfect 50% duty cycle square wave has no even harmonics.

![Square Wave Duty Cycle](image)

**Quick Sweep**

*TrueRTA* uses a digitally synthesized sweep signal of short duration (sometimes called a chirp) to automatically measure the frequency response of a system under test. When you click Quick Sweep the system takes over the generator and analyzer to first generate a sweep output signal and then capture the input and display the frequency response of the unit under test. You can use Quick Sweep for both electronic and acoustic measurements.

The digitally generated signal sweeps logarithmic frequency intervals in equal time. That is, as much time is spent sweeping the interval from 20 to 40 Hz as from 10 k to 20 kHz. This assures a high signal to noise ratio in the low frequency region. Unlike the pink noise source discussed above the digital sweep does not have any “noise” in the amplitude response and does not need to be averaged in order to give precise results. A single sweep is all that is needed in order to measure the frequency response of any unit under test with great precision. The signal level of the sweep is determined by the Generator’s amplitude setting.

Once detected by the analyzer, the response of the sweep is precisely corrected for small errors in the generated sweep and for the roll-off in the sweep’s amplitude below 20 Hz. When Quick Sweep is used along with the Sound System Calibration feature it is normal to see a perfectly flat frequency response plot from 10 Hz to 47 kHz when you perform a self-test of your PC at the maximum sampling frequency. Measurements made using Quick Sweep are typically accurate to within plus or minus 0.05 dB when Sound System Calibration is engaged. When Quick Sweep is employed for acoustic measurements it is normal to use
Sound System Calibration to correct the frequency response of the sound card while also using a microphone calibration file to correct the response of the microphone.

Also see the signal generator dialog bar.
### The Audio I/O Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Audio Input</td>
<td>Starts the audio stream to the Spectrum Analyzer, Oscilloscope and Meters.</td>
</tr>
<tr>
<td>Stop Audio Input</td>
<td>Stops the audio stream to the Spectrum Analyzer, Oscilloscope and Meters.</td>
</tr>
<tr>
<td>Input Selection</td>
<td>Allows selecting between left and right input channels.</td>
</tr>
<tr>
<td>Input Sampling Frequency</td>
<td>Selects the input sampling frequency for audio signal conversion.</td>
</tr>
<tr>
<td>Output Sampling Frequency</td>
<td></td>
</tr>
<tr>
<td>CPU Speed Setting</td>
<td></td>
</tr>
<tr>
<td>Line Input Calibration...</td>
<td></td>
</tr>
<tr>
<td>Line Out Calibration...</td>
<td></td>
</tr>
<tr>
<td>SPL Calibration...</td>
<td></td>
</tr>
<tr>
<td>Sound System Calibration...</td>
<td></td>
</tr>
<tr>
<td>Use Sound System Correction</td>
<td></td>
</tr>
<tr>
<td>Open a Mic Calibration File</td>
<td></td>
</tr>
<tr>
<td>Use Mic Calibration Correction</td>
<td></td>
</tr>
<tr>
<td>Open House Curve File...</td>
<td></td>
</tr>
<tr>
<td>Use Inverse House Curve</td>
<td></td>
</tr>
</tbody>
</table>

The commands under the Audio I/O menu are as follows:

**Start Audio Input**

This command starts the audio stream to the Spectrum Analyzer, Oscilloscope and Meters. From the keyboard you can use **Alt+Space** to start and stop audio processing. Alternately you can use the corresponding toolbar buttons to start and stop the audio stream.

**Stop Audio Input**

This command stops the audio stream to the Spectrum Analyzer, Oscilloscope and Meters. You can also press **Alt+Space** once to start audio processing and again to stop processing. Alternately you can use the corresponding toolbar buttons to start and stop audio processing.

**Input Selection**

This menu item allows you select between the left and right input channels. You can also select L+R or L-R to use either the sum of the two input channels or the difference as the input to the oscilloscope or analyzer. The oscilloscope also has the option of displaying both L and R inputs in dual trace mode.

**Input Sampling Frequency**

This pop up menu lets you select the input sampling frequency for the audio signal conversion to the digital domain. You can select sampling frequencies in steps from 8 kHz to 96 kHz. The frequency response of input audio will be limited to half the sampling frequency. Most users will get the best performance with the default 48 kHz sampling frequency. Older sound cards may only work at the 44.1 kHz setting. One reason to select a low sampling
frequency would be to get the best possible resolution of low frequency signals where wide
high frequency bandwidth is not required.

Output Sampling Frequency

The output sampling frequency pop up menu allows you to select among 44.1, 48 and 96 kHz
for the output sampling frequency of the signal generator. This option helps provide
compatibility with a wide range of sound cards. If your sound card will not work with the 48
kHz default output sampling frequency then you can usually use the lower sampling rate of
44.1 kHz.

CPU Speed Setting

This menu item sets the internal buffer sizes for the software according to the relative
processing power of your PC. Faster PC’s can use smaller input buffers and keep up with the
audio stream. Smaller buffers result in faster updates and less delay between what you hear
and what you see on the screen.

You can set the CPU Speed according to the power of you computer’s processor.
The setting range is from 1 to 5. The faster your computer’s processor, the higher you can set
the CPU Speed. You will know when you have reached the highest setting for your computer
when the display stops running continuously. If the audio processing stops after running only
a short time it is because the CPU Speed is set too high. In this case you will need to reduce
the CPU Speed setting for uninterrupted operation.

A 500 MHz Pentium III will probably need a low setting of 1 or 2 in order to run
continuously. A 1.8 GHz Pentium IV typically runs at speeds 3 or 4. Lower settings cause the
system to use larger buffers that result in a lower frame rate for the RTA regardless of the
speed of the computer. In order to take advantage of a faster computer make sure to use the
highest speed setting that works reliably with your PC.

Line Input Calibration…

This menu item opens the Line Input Calibration Dialog.

In order to use TrueRTA as a calibrated voltmeter to read accurate signal levels (in dBU or
mV) at the input jacks of your computer’s sound system it will be necessary to first calibrate
the line input. As initially installed, the system will be calibrated for a Sound Blaster Audigy
2 sound card from Creative Labs, Inc. (assuming your mixer is set as described below) The
dialog contains the detailed steps you will need to follow to calibrate the system. Here is what
the Line Input Calibration Dialog looks like:
Note: It is recommended that Audigy 2 sound card users set their Audigy Surround Mixer as follows for best results and for default TrueRTA calibration:

At Master Control:
- Volume = 100%
- Bass = 50%
- Treble = 50%

At Source:
- Wave = 100%
- Line-In = 50%

At Rec:
- Analog Mix = 50%

Line Output Calibration...

This menu item opens the Line Output Calibration Dialog.

In order to use TrueRTA as a calibrated signal generator that will generate precisely the signal level you specify at the Generator Bar you will need to perform the Line Output Calibration procedure. It is normal to perform both calibration procedures as soon as the software is installed. Note that the signal connections are the same for both input and output calibration. Here is what the Line Output Calibration Dialog looks like:
SPL Calibration

This command opens the SPL Calibration Dialog shown below.

Follow the steps in the dialog to calibrate your system for SPL measurements. You will need a sound source of known SPL such as an SPL calibrator.

Also see: SPL Mode
Sound System Calibration

This menu command opens the PC Sound System Calibration dialog. Do not attempt to perform the sound system calibration until you first have Quick Sweep working correctly on your system.

Follow the steps described in the dialog to calibrate your sound system so TrueRTA can automatically remove the frequency response of your PC’s sound system from your measurements. If you perform a self-test of your PC sound system without any correction it is normal to see the response roll off at either frequency extreme and to perhaps see some ripple in the response. Using TrueRTA’s Sound System Calibration completely removes the response of your sound card from your frequency response measurements.

Because this calibration specifically corrects for the combination of the Line-Out and Line-In response errors, it is only appropriate to use Sound System Correction when the PC is used as both the generator and the analyzer and both are actually in the test loop. Do not use Sound System Correction when, for example, using the RTA to analyze music. While it would be appropriate to correct for the Line-In error in this case, the correction for the Line-Out error would not be appropriate and would in fact become a source of error rather than a correction. You definitely will want to use Sound System Correction with Quick Sweep or for Pink Noise testing where the PC is used as the signal source.
When you click OK TrueRTA runs a Quick Sweep to collect the response of your sound card and displays that response on the screen. If you run Quick Sweep again while configured for the loop back test you should see a perfectly flat trace from 10 Hz to 47 kHz (at 96kHz Fs). Now you can measure the frequency response of any unit you place in the test loop with great accuracy. Note that a file named SoundSys.cal will be created beside the TrueRTA application. This file will automatically be loaded each time TrueRTA starts.

1. Make the required Signal Connections:
   - Patch the PC sound system’s Line Output to the Line Input.
2. At your Windows Record Control Panel:
   - Select the Line input and set the Line In fader at MAXIMUM.
3. At your Windows Play Control Panel:
   - Select the Wave output and set the Wave fader at MAXIMUM.
   - Also set the Play Control volume at MAXIMUM.
4. At the TrueRTA Generator Bar:
   - Enter -10 for the generator amplitude.
5. Press OK to generate a calibration file for your PC’s sound system.

When you click OK TrueRTA runs a Quick Sweep to collect the response of your sound card and displays that response on the screen. If you run Quick Sweep again while configured for the loop back test you should see a perfectly flat trace from 10 Hz to 47 kHz (at 96kHz Fs). Now you can measure the frequency response of any unit you place in the test loop with great accuracy. Note that a file named SoundSys.cal will be created beside the TrueRTA application. This file will automatically be loaded each time TrueRTA starts. For the most stable results perform this procedure only after your PC and sound system have had a few minutes to warm up from a cold start. Again, you should not attempt sound system calibration until you first have Quick Sweep working correctly.

Use Sound System Correction

Use this command to switch the sound system correction off and on. Only use Sound System Correction for measurements where the PC is used as both the generator and the analyzer. This setting will be remembered from session to session.

Open a Mic Calibration File...

If you have had your mic calibrated or otherwise know the frequency response of your measurement microphone then TrueRTA can automatically remove that response from your acoustical measurements. This command brings up an open dialog that lets you locate and open a microphone correction file you can use for your acoustic measurements.
Microphone calibration files are files of type .txt that contain anywhere from 1 to 800 data points describing the response of the microphone. The file must contain no other text, just data formatted as shown below:

```
20  -3.25
50  -1.75
100 -0.33
1000  0.0
10000 -1.1
20000 -2.95
```

The first number on each line is the frequency and the second number is the response in dB at that frequency. There should be one line per data point with the data separated by either spaces or tabs. This is the standard form in which many microphone calibration files are supplied.

TrueRTA employs the mathematical method of cubic spline interpolation to create a smooth correction curve from the data points you provide. When you load a mic correction file the response is immediately plotted at 0 dB for your inspection.

The most recently used mic correction file will automatically be loaded each time you launch TrueRTA. You can switch mic correction on and off as needed using either the command below or the corresponding Toolbar button. You can tell what mic correction file is currently loaded by inspecting the Auto Notes that are generated each time the analyzer is run. Often it is appropriate to use Mic Calibration in combination with Sound System Correction and/or House Curve voicing.

**Use Mic Calibration Correction**

This command lets you switch mic calibration on and off as required for your measurements. The system has no way of knowing whether you are performing an electrical or an acoustical measurement so it is up to the user to determine whether mic correction should be applied to a measurement or not. Place your mic correction files in your TrueRTA folder. If no mic correction file is loaded then this command is disabled. Mic Calibration can also be switched on and off at the Toolbar.

**Open House Curve File…**

You can apply a “house curve” to your measurements as you make them using TrueRTA’s House Curve feature. Use of a house curve is appropriate for voicing full size film theaters, home theaters, music studios, music performance halls and home hi-fi systems. Once you equalize your system to achieve a flat response using a house curve then you will have actually achieved the target response represented by the house curve. House curve files are simple .txt files just like those used for mic calibration files above. Each line of the file contains a frequency and a dB level. A folder named House Curves is provided in the TrueRTA folder. It contains files with the large room and small room x-curves. You can also create and use as many additional curves as you may need. When a House Curve is opened the actual curve is plotted on the screen for you to see. However, to be clear, it is the inverse of the x-curve that is actually applied to measurements.
Use Inverse House Curve

Switch house curve compensation on and off using either this menu command or its corresponding Toolbar button. This setting affects new measurements only. If no house curve file is loaded then this command is disabled. House Curve usage can also be switched on and off at the Toolbar. When a house curve is employed, the house curve will be achieved when you measure a flat response. See Application Note 2 for more information.
TrueRTA’s oscilloscope allows you to view the input signal waveform. You can also freeze and print the wave at any time. Use the space bar on your keyboard to start and stop the scope. The commands under the Oscilloscope menu are as follows:

**Oscilloscope Mode**

This command switches TrueRTA to the oscilloscope mode from the analyzer mode. You can also use the toolbar buttons to switch between modes.

**Time per Division**

Use this popup menu to set the oscilloscope’s time base. Alternately you can also set the time base from the oscilloscope dialog bar.

**Volts per Division**

Use this popup menu to set the oscilloscope’s input voltage display range. Alternately you can also set the voltage from the oscilloscope dialog bar.

**Trigger Source**

These two commands allow you to select between the left and right channels as the source for oscilloscope sweep triggering.

**Display Time and Volt Scales**

The selected time and volt scales are normally displayed at the bottom of the oscilloscope screen. This command allows you to switch the scale display off and on as desired.

Also see the oscilloscope dialog bar.
**TrueRTA's** Spectrum Analyzer shows you the spectrum of the audio input signal in real-time. Commands under this menu are used to control the Spectrum Analyzer functions.

### RTA Mode

This command switches **TrueRTA** to the RTA mode from the oscilloscope mode. You can also use the corresponding toolbar buttons to switch between modes.

### Peak Hold

When the peak hold feature is selected the analyzer holds the highest peak level attained by each frequency band. Note that the use of peak hold is not recommended for pink noise testing.

### 1 Octave RTA

Sets the analyzer to display data in the form of one octave wide bars. There are 10 bars in the audible frequency range from 20 Hz to 20 kHz.

### 1/3 Octave RTA

Sets the analyzer to display data in the form of 1/3rd octave wide bars. There are 30 bars in the audible frequency range from 20 Hz to 20 kHz.

### 1/6 Octave RTA

Sets the analyzer to display data in the form of 1/6th octave wide bars. There are 60 bars in the audible frequency range from 20 Hz to 20 kHz.
1/12 Octave RTA

Sets the analyzer to display data in the form of 1/12th octave wide bars. There are 120 bars in the audible frequency range from 20 Hz to 20 kHz.

1/24 Octave RTA

Sets the analyzer to display data in the form of 1/24th octave wide bars. There are 240 bars in the audible frequency range from 20 Hz to 20 kHz.

Speed Tradeoff

This pop up menu lets you select between 20 Hz (slow but precise), 40 Hz (medium) and 80 Hz (fastest) modes for the spectrum analysis. The fast 80 Hz setting uses the shortest FFT and gives the fastest frame rate at the expense of low frequency resolution while the precise 20 Hz setting provides maximum precision at a slower frame rate. Always use the 20 Hz (slow) setting when collecting important low frequency measurement data. This is the setting that will automatically be selected when you use Quick Sweep. The 40 Hz (medium) and 80 Hz (fast) settings allow for faster displays at the expense of low frequency resolution. They are intended more for viewing live audio on slower PCs than for taking laboratory grade measurements. The approximate useful low frequency limits for the settings are 20, 40 and 80 Hz respectively at an input sampling frequency of 48 kHz. You can also select the speed tradeoff at the analyzer dialog bar.

RTA Bar Mode

With the bar mode selected the analyzer displays the frequency band data as solid bars rising from the bottom of the display up to the indicated signal level. When the bar mode is turned off the data is displayed as a line plot where one point is plotted in place of each bar. The bar mode is appropriate for analyzing live or recorded audio. The line mode is most suitable for displaying a conventional frequency response plot…such as the frequency response of electronic gear obtained with TrueRTA’s Quick Sweep. You can also select the bar mode at the toolbar.

Relative Mode

When selected, this command places the analyzer in Relative Mode or “Rel Mode”. When the command is selected the current response is saved and then subtracted from subsequent response plots. Use this feature to zero out response aberrations when you want to specifically measure the difference between two responses. Note that there is a corresponding Toolbar button labeled “REL”. Clicking the menu command or Toolbar button a second time switches out of Relative Mode and returns the system to normal.

SPL Mode

This command switches the analyzer from dBu mode to dB SPL mode. The analyzer scale switches from reading dBu in the range from −160 to +20 dBu to reading dB SPL over the range from 0 to +180 dB SPL. The frequency selection in the dialog bar changes to match the dB scale.

Also see: SPL Calibration
High Frequency Limit

Use this pop up menu to select the high frequency limit for the display. Alternately you can make this selection at the spectrum analyzer dialog bar.

Low Frequency Limit

Use this pop up menu to select the low frequency limit for the display. Alternately you can make this selection at the spectrum analyzer dialog bar.

Upper dB Limit

Use this pop up menu to select the upper amplitude limit for the display. Alternately you can make this selection at the spectrum analyzer dialog bar.

Lower dB Limit

Use this pop up menu to select the lower amplitude limit for the display. Alternately you can make this selection at the spectrum analyzer dialog bar.

Averages

This pop up menu allows you to select the number of averages of the data to display. Normally this is set to 1 to indicate that only the current (un-averaged) data should be displayed. When working with signals that contain a lot of random noise (such as pink or white noise) a much smoother response can be obtained by averaging several frames of data. When observing live audio the display can be smoothed out a bit by using an average setting of just 2 or 3. For the smoothest response curves when using pink noise as the test signal set the number of averages as high as 100,000 and allow data to accumulate for several minutes or more until no further smoothing is achieved. The pop up menu provides a short list of preset averages but you can enter any number you wish at the analyzer dialog bar.

Also see the spectrum analyzer dialog bar.
TrueRTA’s digital voltmeter displays its measured levels right on the analyzer and oscilloscope displays. The menu selections allow you to select which meter functions will be displayed. By default the meter displays will print on your printed report. However there is a preference selection to defeat the meter print out if desired.

**Input Level in mV**

Select this item to switch the millivolt display on or off. Alternately you can switch each meter display on or off at the oscilloscope dialog bar.

**Input Level in dBu**

Select this item to switch the dBu display on or off. Alternately you can switch each meter display on or off at the oscilloscope dialog bar. Both dBu rms and dBu peak are displayed.

**Crest Factor in mV/mV**

Select this item to switch the crest factor millivolt display on or off. Alternately you can switch each meter display on or off at the oscilloscope dialog bar.

**Crest Factor in dB**

Select this item to switch the crest factor dB display on or off. This is the usual mode for metering crest factor. Alternately you can switch each meter display on or off at the oscilloscope dialog bar.

**All On**

This command switches on all of the meter displays.

**All Off**

This command switches off all of the meter displays.

Also see the [digital metering overview](#) for more information on the meter functions.
Utilities Menu

The TrueRTA utilities allow you to post process your measured responses with smoothing, shifting, differencing and averaging functions. Note that each utility processes the underlying FFT data of the responses…not simply the displayed RTA points.

The commands under the Utilities menu are as follows:

**Average**

The memory averaging utility lets you take the average of up to 20 responses that you have previously saved to the memories. Optionally you can also specify a 5 or 10 dB shift up or down for the resulting average response. For most work you will want to accept the default dB type average but there are occasions where a linear or RMS average is appropriate. Note that all curves to be averaged must have been collected with the same resolution and tradeoff settings so that they have the same FFT size. When averaging responses measured with pink noise it is generally helpful to first apply some smoothing to each curve before proceeding with the average.

**Smooth**

The curve smoothing utility lets you specify a fractional octave bandwidth for smoothing. Increase the fractional bandwidth for greater smoothing. The smoothed response can optionally be shifted 5 or 10 dB up or down. Note that smoothing gets to be math intensive as
the fractional bandwidth is increased. So expect to wait a few seconds for a .333 octave smoothing procedure.

**Shift**

Use the curve shifting utility to shift a response up or down by a fixed amount. This is useful when overlaid curves need to be aligned for comparison or for shifting a curve away from a group of curves for comparison.

**Sum**

This Summing utility adds two response curves and saves the result in the specified memory. This is useful for seeing the combined frequency response of two series connected audio systems.

Note that the curves to be summed must have been collected with the same resolution and tradeoff settings so that they have the same FFT size. Also, note that the Sum Utility is only
calibrated for dBu mode so summing curves in the SPL mode will not appear calibrated even though the shape of the resulting curve will be correct.

**Difference**

This Difference utility subtracts two response curves and saves the result in the specified memory. Use this utility, for example, to find the difference between the response of a loudspeaker measured by the ground plane technique and the speaker’s in-room response.

Note that the curves to be differenced must have been collected with the same resolution and tradeoff settings so that they have the same FFT size. The difference utility works in both dBu and dB SPL modes.
Memory Difference Utility

This utility lets you subtract two frequency responses which are saved in memories.

1) Select the starting memory and the memory to be subtracted.
2) Next, select the memory location for the resulting difference response.
3) The subtraction will be performed when you click the OK button.

<table>
<thead>
<tr>
<th>Select the starting memory:</th>
<th>Select the memory to subtract:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  6  11  16</td>
<td>1  6  11  16</td>
</tr>
<tr>
<td>2  7  12  17</td>
<td>2  7  12  17</td>
</tr>
<tr>
<td>3  8  13  18</td>
<td>3  8  13  18</td>
</tr>
<tr>
<td>4  9  14  19</td>
<td>4  9  14  19</td>
</tr>
<tr>
<td>5  10  15  20</td>
<td>5  10  15  20</td>
</tr>
</tbody>
</table>

Select Memory to use for the RESULT:

| 1  6  11  16 |
| 2  7  12  17 |
| 3  8  13  18 |
| 4  9  14  19 |
| 5  10  15  20 |

[OK] [Cancel]
The commands under the Help menu are as follows:

**Help Topics**

The complete *TrueRTA* User’s Guide can be found under the Help Topics menu.

**User Registration**

Enter your personal information in this window. Enter the User Registration Code here to upgrade to a more powerful version of *TrueRTA*.

**About TrueRTA**

Displays the *TrueRTA* version number, copyright and licensed user information.
Signal Generator Overview

In order to evaluate an audio product, whether an audio equalizer, amplifier or a loudspeaker, it is necessary to have both a stimulus test signal that you send to the unit under test and an analyzer with which to measure various characteristics of the output signal returning from the unit under test. The signal generator’s signal flow is from the software to the PC sound system’s line output that is patched to the input of the unit under test. The output signal from the unit under test is then patched back to the PC sound system’s line input and on to TrueRTA’s analyzer.

The TrueRTA signal generator produces an ultra low-distortion sine wave variable from 5.0 Hz to 48 kHz. The output level is specified in dBu. In addition to the sine wave, the generator can also generate square, triangle, saw tooth and impulse waveforms as well as pink noise and white noise. The duty cycle of the square wave is adjustable.

The higher-level versions of TrueRTA also provide a digitally synthesized logarithmic sine sweep from 10 Hz to 48 kHz. This precision test signal is digitally synthesized in the frequency domain and then transformed to the time domain for output. This digital sweep is a high-resolution alternative to using pink noise or swept sine methods for system testing. The swept sine wave provides a consistent signal level at each frequency and lacks the peaks and valleys seen in pink noise response plots. The digital sweep is an excellent alternative to stepped sine wave testing. The sweep has a frequency response that is very flat being within plus or minus 0.05 dB from 10 Hz to 45 kHz. In comparison, averaged pink noise has a variation of about plus or minus 1.5 dB over the audible frequency range. The digitally generated sweep is clearly superior to pink noise as a precision test signal.
Signal Generator Dialog Bar

Although some generator functions are available at the Generator menu the generator is normally controlled from the generator dialog bar shown below. The dialog bar normally appears at the left of the screen but can be hidden at the View menu if required.

At the top of the dialog bar is the On/Off button that starts and stops the generator output. Below the On/Off switch is the Frequency field where you enter the frequency for the sine wave generator. The generator can produce fractional frequencies such as 20.5 Hz, which is very useful in low frequency testing where integer (whole number) frequencies are too coarse. The up/down buttons allow you to step the sine wave frequency up or down in steps of various sizes. Normally the frequency is stepped in musical half tones or 1/12\textsuperscript{th} octave steps. If the Shift key is held down while stepping then the step size is increased to one octave. If the Ctrl key is held down then the step size is reduced to 1 Hz. You can also use the keyboard up/down cursor control arrows to step the up/down buttons.

Below the Frequency field is the Amplitude field where you enter the desired signal level in dBu. Note that 0 dBu is 0.775 Vrms. The up/down buttons allow the amplitude to be stepped up or down in steps of various sizes. Normally the amplitude is stepped in 1 dB increments. If the shift key is depressed the step size is increased to 10 dB. When the Ctrl key is held down the step size is reduced to 0.1 dB.

Push buttons below the Amplitude field allow for the selection of sine, square, triangle, saw tooth, or impulse waveforms along with pink noise or white noise.

At the bottom is the Quick Sweep button. Quick Sweep allows you to measure the frequency response of a system under test (electronic or acoustic) with a single click.

Also see the corresponding signal generator menu commands.
Spectrum Analyzer Overview

The real time spectrum analyzer displays the magnitude of the input signal versus the frequency of the signal. As is typical for audio work, the frequency response is plotted on a logarithmic frequency scale on the horizontal axis with the magnitude displayed in dB on the vertical axis. The speed at which the display updates will depend on several factors including the speed of your PC’s processor, the CPU Speed Setting (at the Audio I/O menu), the RTA Resolution (bar width) and the Speed Tradeoff setting.

The input to the Spectrum Analyzer is selected at the Toolbar. You can choose to analyze the left input channel, the right input channel, the sum L+R or the difference L-R. The input selection for the spectrum analyzer is remembered separately from the oscilloscope’s input selection.

Because TrueRTA will require almost all the processing power your computer has available it is generally recommended that you not run any other processor or memory intensive software applications when using TrueRTA. If you do run other software with TrueRTA then you will want to stop the input processing (by hitting the space bar) before using the other software. If you leave TrueRTA running you will likely notice sluggish behavior from the other software applications as they compete with TrueRTA for processor time. Likewise, TrueRTA’s performance may be compromised with other software running. This can result in the input processing stopping automatically in order to free up the overtaxed computer.

Once you have a spectrum on the screen you can click on the line (or bar) to see a detailed cursor readout of the frequency and dB data for that point along with the memory location of the data. Click again to hide the cursor box. The cursor box also prints with the printed report. Each memory retains its cursor selection status when the project file is saved.
Spectrum Analyzer Dialog Bar

Most of TrueRTA’s spectrum analyzer commands are available at the Spectrum Analyzer menu but the spectrum analyzer is more often controlled from the spectrum analyzer dialog bar shown below. The dialog bar normally appears at the right of the screen when TrueRTA is in the analyzer mode but can be hidden at the View menu if desired.

At the top of the dialog bar are two edit fields for selecting the upper and lower dB limits of the display. The upper limit can be set between +20 dBu and –150 dBu while the lower limit ranges from +10 dBu down to –160 dBu. (or from +180 down to 0 dB SPL in SPL mode) The up/down buttons are used to step the dB limits in 10 dB increments. The major grid intervals are 5, 10 or 20 dB depending on the dB range spanned and the size of the window.

Below the dB limit buttons are two edit fields for selecting the frequency limits of the active plot area. The lower limit ranges from 10 Hz up to 20 kHz while the upper limit can be set from 50 kHz down to 50 Hz. The up/down buttons are used to step the limits through standard frequencies at approximate one-octave intervals. The keyboard cursor up/down arrows can also be used to control the edit field up/down buttons.

At the bottom of the dialog bar are three fields for setting the resolution, the speed tradeoff and the number of averages. The resolution field has a popup list with fractional octave resolution selections of 1 octave, 1/3, 1/6, 1/12 and 1/24th octave depending on the level at which the software is licensed.

The Speed Tradeoff list allows the selection of 20 Hz (slow but precise), 40 Hz (medium speed) or 80 Hz (fastest) as tradeoffs in buffer and FFT sizing. The slow setting should be used when speed is not a consideration as it is the most accurate in the lowest octaves. The medium and fast settings allow for faster frame rates when using the RTA to analyze live music and maximum resolution in not required in the lowest octaves.
The Averages field allows you to enter any number for the number of averages to use for the display data. Set this number to 1 for the fastest updates. Set it higher to reduce the display activity and see a time average of the spectrum.

For more information, see the descriptions of the spectrum analyzer menu items corresponding to these commands.
Selecting a Signal Source for Analysis

Before you can use TrueRTA productively, you will need to understand how to use the Windows audio mixers (and perhaps your sound system’s custom mixers) in order to select among the various input signals that are available to your PC sound system. The signal that serves as the input to the analyzer is selected at the Windows Record Control mixer (or the Record section of your custom mixer). Here is how to access the Windows Record Control to select the desired signal source:

1) Open the Windows Volume Control:
   - From the Windows task bar, right click on Volume and select “Open Volume Controls”
     (Alternately, from the Start button select: Programs/Accessories/Entertainment/Volume Control.)

2) Switch to the Recording Mixer:
   - From the Volume Control’s Options menu select Properties.
   - At the Properties window’s “Adjust volume for” section select “Recording”.
   - Click on the OK button to close the window and bring up the Record Control mixer.

Here are the typical input signal selections that are available at the Recording Mixer:

Microphone Input Selection

At the Record Control mixer select the Microphone input when you want to analyze the signal from a microphone plugged into the sound system’s “Mic In” jack. You will also have to make sure to raise the fader for the mic input. Inexpensive multimedia microphones (such as those built into many laptop computers) are usually accurate enough for the casual analysis of live sound sources. (If you hear the mic through your speakers then lower the speaker volume at the task bar.) For precision acoustical analysis you will most likely NOT be using the PC’s mic input but rather you will use a professional mic and microphone preamplifier to feed the PC’s “Line Input” jack.

Line Input Selection

In order to use the Line Input you will need to select Line-In at the Windows Record Control mixer and raise the Line-In fader. For precise acoustical measurements you should feed your PC’s Line Input from the output of a microphone preamplifier used with a calibrated measurement microphone. The line input will also be used for most electronic testing where the output from the unit under test is connected to the PC’s “Line In” jack. Power amps should probably be connected to the Line-In only by using an in-line attenuator of at least 20 dB. (10 k Ohm series resistor with 1 k Ohm across the Line-In jack)

Wave Signal Selection

If you are analyzing a signal that originates within the computer (such as a .wav file or the direct digital output of TrueRTA’s signal generator) you will need to select “Wave” at the Windows Record Control mixer and raise the Wave fader.

CD Audio Signal Selection

You can analyze audio directly from a CD by selecting CD Audio at the Windows Record Control mixer and raising the CD Audio fader to maximum. Depending on how your computer is configured, you may be able to also select CD Digital and use the direct digital output of the CD as your input signal for analysis.
“What U Hear” Signal Selection

Sometimes you just want the analyzer input to be the same as whatever you are listening to and you don’t care about calibration. In this case you can select “What U Hear” at the Windows Record Control mixer and raise the “What U Hear” fader. Then the input to the analyzer will be the same signal that you select at the Windows Play Control mixer.

If you have not done so, it is a good idea to go through the Getting Started Quickly topic to get a computer microphone connected and selected as the analyzer input. This is a good starting point for quickly learning how to use the analyzer and oscilloscope.

Note: The signal you select for input at the Windows recording mixer will feed the spectrum analyzer, the level meter, the crest factor meter and the oscilloscope.
Typical Applications of the Spectrum Analyzer

There are many uses for an audio spectrum analyzer. Here are just a few:

- Measure the frequency response of various types of audio equipment
- Analyze the distortion characteristics of audio equipment
- Study the noise characteristics of acoustic environments or electronic gear
- Professional audio recording, mixing and mastering
- Audio product design and production testing
- Voice and music learning aid
- Design and evaluation of musical instruments harmonic structure

Some of the above applications require the use of the analyzer in combination with a test signal from the generator; others (such as noise analysis or analyzing live or recorded music) require no test signal.
Oscilloscope Overview

TrueRTA’s oscilloscope shows you the input audio waveform with amplitude on the vertical scale versus time on the horizontal scale.

The dual-trace oscilloscope displays the input signals in several different modes. The input modes include:

- **L** Left Channel
- **R** Right Channel
- **L R** Left and Right Channels (dual trace)
- **L + R** Sum of Left and Right Channels
- **L - R** Difference of Left and Right Channels.

The voltage range can be adjusted from 5 V per division down to 0.001 V per Division. The time base ranges from 200 ms/Division down to 0.05 ms/Div. The traces can be triggered from either the Left or Right inputs. The trace can be frozen at any time by pressing the space bar. Oscilloscope controls are available at both the scope menu and at the detachable dialog bar. The input to the oscilloscope is selected at the main Toolbar. The background and trace colors for the scope display can be switched among 5 different color schemes at the View menu. The user’s notes are saved along with the trace currently on the workbench with each project file.
**Oscilloscope Dialog Bar**

Whenever you switch from the spectrum analyzer mode to the oscilloscope mode the dialog bar at the right of the screen switches from the spectrum analyzer dialog bar to the oscilloscope dialog bar shown below. Like the spectrum analyzer bar, the scope dialog bar duplicates the commands found under the same named menu.

At the top left of the bar is a vertical group of buttons labeled V/Div for selecting the scope’s voltage sensitivity from 5 Volt per division down to .001 Volts per division. Another vertical group of buttons labeled ms/Div sets the time base of the scope in the range between 200 ms/Div and .05 ms/Div.

At the bottom is a pair of buttons for selecting between the left and right inputs for use as the scope’s trigger signal.

Note that the trace can be started or stopped at any time by pressing `Alt+Space`. Controls are available at both the scope menu and at the detachable dialog bar. At high frequencies, the sound card’s sampling rate limits performance and the waveform begins looking course due to individual samples becoming distinctly visible.

Also see the oscilloscope menu item descriptions for more information.
Digital Metering Overview

Input Level Meter

The input voltmeter reads the signal selected at either the spectrum analyzer input or the scope input depending on which mode is active. If you are using the scope then the input you select for the scope will also feed the meters. Likewise for the analyzer, if you are using the real time analyzer then the analyzer’s input will feed the meters.

The voltmeter can display the following levels:

- Input Level in millivolts
- Input Level in dBu rms (0.774597 Vrms reference, or 1mW @ 600 Ohms)
- Input Level in dBu peak

When the dB display is selected a solid vertical bar is drawn at the left edge of the plot screen to indicate the overall dB level of the signal. Floating above the top of the bar is a line that indicates the peak signal level.

Upon first installing TrueRTA you should calibrate the voltmeter for your sound card. See the Audio I/O Menu for full details on how to calibrate your system so that it reads input signal levels accurately. You will need an AC voltmeter separate from TrueRTA so that you can accurately measure the signal level. You will enter that value at the calibration dialog and then your TrueRTA will be calibrated for your sound card and provide you with precise measurement of input signal levels. Here is a link to the Edit menu for the calibration commands: Line Input and Output Calibration.

Crest Factor Meter

The crest factor of a signal is the ratio of the signal’s peak level to its rms level. It tells you how loud the peaks are compared to the rms signal level.

The crest factor meter has two display choices:

- Crest Factor in mV/mV (ratio of peak to rms level)
- Crest Factor in dB

For certain signals the crest factor is well defined. Consider a sine wave with a level of 1 Vrms. We know this wave will have a peak level of 1.414214 (square root of 2) times its rms level. So, the crest factor of a perfect sine wave will be 1.414 V per V. In terms of dB this ratio is 3.01 dB.

Next consider an ideal square wave. A square wave with amplitude of 1 Vrms will also have a peak voltage of 1 V. The crest factor of a square wave is thus 1, or 0 dB.

Also consider a triangle wave. The rms voltage of a triangle wave is 0.577 times its peak voltage. So a triangle wave will have a crest factor of 1.732, or 4.77 dB. Saw tooth waveforms have the same crest factor as the triangle wave. Impulse waves can have much higher crest factors due to their low rms values for a given peak level.

Different waveforms have different crest factors depending on the shape of the waveform. The crest factor for recorded music is generally in the neighborhood of 3 or about 10 dB. In general, the more highly processed the music; the lower will be the crest factor. In the practice of modern...
audio production audio peak limiting is often used to minimize the largest signal peaks and therefore reduce the crest factor of the music so that it presents a higher overall “loudness” or rms signal level.

Because the crest factor is a pure ratio of peak to rms signal level it needs no calibration. Items under the Metering menu and on the toolbar allow each meter function to be switched on or off. Selected functions are displayed at the top of the oscilloscope or spectrum analyzer window. The meter displays can also be switched on and off at the main toolbar.

Also see the Metering Menu item descriptions.
How RTAs Evolved

Back in the late 1970’s and early 1980’s audio engineers started using real time analyzers, or RTAs, to display the spectrum of audio signals such as that from a microphone. These early analyzers worked by using a collection of electronic bandpass filters. Each band was typically one-octave wide, and the bands were distributed on center frequencies spaced in one-octave intervals. The most popular octave center frequencies are: 62.5 Hz, 125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, 4 kHz, 8 kHz and 16 kHz. One full range audio signal was input to the bank of bandpass filters with the output of each filter representing the signal level for that frequency band. Then, the output of each filter would be fed into something equivalent to a VU meter, usually an LED display, to show the loudness of the signal in each frequency band. By placing the level displays side by side they formed a live graph of the audio signal and we were able to see the bass versus the treble energy, or perhaps a peak in the midrange…all in real time as the music played.

In those early days of RTAs the popular analyzers had an LED display with a bar graph that displayed 10 bars as an octave equalizer. Each bar was driven by the output of one of the bandpass filters. In search of better resolution, engineers then divided the frequency bands into even more narrow bands. From one-octave frequency bands we advanced next to 1/3-octave bands, going from 10 bands to 30 bands across the audible spectrum. Today even finer bands are used for audio analysis.

More recently, digital technology has given us a new way to achieve the same results. Today, once we have a signal in the digital domain, such as with a PC and sound card, we can bring to bear the awesome power of digital signal processing or DSP. Modern personal computers now have enough power to do a significant amount of processing of live audio signals.

By using powerful DSP methods, TrueRTA displays 1/24th octave wide bands with a total of about 240 bands spanning the full audio spectrum…all in real time as it happens!
The Math Behind TrueRTA's Spectrum Analysis

TrueRTA accomplishes the first part of its processing using an FFT, that is, the mathematical Fast Fourier Transform. The French mathematician Fourier, after whom the process is named, showed us how to convert a signal from a waveform into a frequency spectrum. His mathematical transform can be used to shift from the time domain view of a signal to the frequency domain view of that same signal and then back again to the time domain waveform. While the input audio waveform has time plotted on the horizontal axis, the FFT’s output spectrum has frequency on the horizontal axis. In this view of the audio signal we see lows to the left and highs to the right, with loudness on the vertical. Usually the magnitude (loudness) scale is calibrated in dB. The horizontal scale is logarithmic in frequency so that each octave or fractional octave has the same width. Further specialized processing is required to transform the FFT response into the RTA response familiar to audio engineers. In TrueRTA the time domain view is provided in the form of an Oscilloscope, an electronic test instrument familiar to most audio engineers. TrueRTA’s frequency view of the input signal takes the form of a Real Time Analyzer with resolution adjustable from 1 octave to 1/24th octave.

The PC’s sound system converts the analog input signal (say, from a microphone) into a digital signal that TrueRTA then processes through a FFT to find the loudness of each frequency band. The width of each band is inversely related to the total number of waveform data points input to the FFT. For example, a 1k FFT operates on 1024 data points of the audio waveform. A 4k FFT operates on 4,000 or so data points. TrueRTA uses either 4k, 8k, 16k, 32k or 64k FFTs as the starting point for its RTA displays. The 64k FFT outputs over 32,000 bands of very fine frequency detail! The higher resolution displays employ larger FFTs that in turn require more processing. The result is that the higher the resolution of the display the slower the display will update.

Due to the linear frequency nature of the FFT most of our data points are bunched up in the higher frequency range – indeed half of our 32,000 bands are in top octave alone, from 10 kHz to 20 kHz. In the high frequency range the FFT has extremely fine resolution that becomes progressively coarser at lower frequencies. Unlike an RTA, at the low frequency end of the spectrum the FFT’s frequency bands become wide and the resolution decreases. Audio engineers generally prefer to see spectra displayed in fixed fractional octave steps that appear as bands of the same width when viewed in the usual log frequency response format. Ultimately, what sets the requirement on the size of the FFT is the combination of the sampling frequency and the RTA’s required low frequency resolution.

In order to begin converting the FFT output into a RTA display we first process our FFT bands to find the rms amplitude for each fractional octave band. Next we have to apply a transform that corrects for the fact that the FFT and RTA have different spectral weighting characteristics. While pink noise appears as a flat response on an RTA, it will have a response falling at 3 dB per octave on an FFT display. White noise appears as flat on an FFT but exhibits a rising response on an RTA. Processing the fractional octave band amplitudes through a “bluing” filter then achieves the response-weighting characteristic of the traditional RTA.

Today our PCs have grown to have enough processing power that TrueRTA can deliver adequate frame rates for resolutions up to about 1/24th of an octave. For this reason we fully expect that over time we will be able to provide even higher resolution RTAs at ever faster frame rates.
Measuring Frequency Response Using Pink Noise

When using the analyzer to measure the frequency response of a piece of audio equipment such as an equalizer, amplifier or loudspeaker you will also use either the pink noise or sweep test signal. Here is a general description of how you might use pink noise to perform a frequency response test on a piece of electronic gear such as an audio equalizer.

- Connect the Line Out of the PC to the input of the equalizer.
- Connect the output of the equalizer back to the Line In jack of the PC.
- Select Pink Noise at TrueRTA’s generator and set the output level to, say –10 dBu.
- Specify a large number (1000 or more) of averages for the response.
- Set the analyzer’s frequency limits appropriately, say 20 to 20 kHz.
- Set the analyzer’s dB limits appropriately, say 0 dB at the top and –40 dB at the bottom.
- Start the generator and analyzer and accumulate a significant number of averages.
- Stop the analyzer and save the results to a memory.
- Smooth the measured response to remove some of the “noise”.
- Save the project file for future reference.
Measuring Frequency Response Using Quick Sweep

Here is a general description of how you can use Quick Sweep to perform a frequency response measurement on a piece of electronic gear such as an audio equalizer. This test assumes you have already performed the Sound System Calibration procedure to remove the response of your PC’s sound system from the measurements.

- Connect the Line-Out of the PC to the input of the equalizer.
- Connect the output of the equalizer back to the Line-In jack of the PC.
- Set the Generator’s amplitude to –10 dBu.
- Set the analyzer’s frequency limits appropriately, say 20 to 20 kHz.
- Set the analyzer’s dB limits appropriately, say +10 dB at the top and –30 dB at the bottom.
- Press the Quick Sweep button and the sweep is performed and results plotted to the screen. Notes regarding the measurement parameters are automatically generated.
- Save the measured response to memory.
- Smoothing is not generally necessary when using Quick Sweep to measure electronic gear, as the measured curves will typically be very smooth. Acoustic measurements may require some smoothing in order to be “presentable”.
- Save the project file for future reference.
Measuring a Loudspeaker's Frequency Response

To perform similar tests on a loudspeaker you will route the Line Out through a power amplifier to the speaker under test as shown below. Play a 200 Hz sine wave and set the playback volume to be moderately loud. Then place a microphone in front of the speaker and either connect the microphone directly to the PC’s mic input or connect it through a mic preamplifier and then on to the PC’s line input. The test configuration for the case where the mic preamp is used is shown below. For casual non-critical testing an inexpensive computer mic can be used and plugged directly into the PC’s mic input. For precision testing you will want to use a measurement microphone with a very accurate frequency response combined with a precision microphone preamplifier. Make sure you select the appropriate input (Line-In or Mic-In) at your PC’s record mixer.

Mic Placement

The microphone is usually placed 1 meter directly in front of the loudspeaker. You may also want to measure the off axis response at 30 and 60 degree angles. A more elaborate test might take off axis responses at increments through a full 360 degrees.

Loudspeaker Testing Environment

If you measure a loudspeaker in your living room or any interior space, you’re going to get the combination of the speaker’s direct sound plus all the room reflections and resonances. The room can have a large effect on the measured response so we always look for ways to reduce the amount of room sound we collect in our measurement. One way to get rid of the room’s effect is to move the test situation to an anechoic chamber that ideally has no reflected energy so that the only sound arriving at the mic will be the direct sound from the loudspeaker. Even better is to make your measurements outdoors in a quiet open area. Indoors, you can perform limited frequency range testing using the nearfield method described below.

Half-Space Measurement Using an Outdoor Test Pit

A good way to eliminate the reflections and resonances that occur inside is to simply take the measurements outdoors in an open area away from buildings or other strong reflecting surfaces. Create a speaker test pit pit such that you can place your speaker under test in the pit face up and be able to adjust the height so that the face of the speaker is flush with the ground surface. Fill around the speaker as necessary.
to create the effect of the speaker being flush with a solid ground surface. Then locate the mic directly above and some distance from the speaker and you can get a precise half-space measurement. Your microphone will be collecting direct sound from the speaker under test and there will be no reflections to muck up the measurement. Under these conditions you can collect good data at a wide range of mic distances. Your speaker test pit might be as simple as an earth pit lined with plastic or as elaborate as a custom poured concrete test bed with buzz-proof enclosure clamps and precision adjustments for height.

**Ground Plane Measurement Outdoors**

Another popular way to measure loudspeakers is to do a ground plane measurement. Instead of locating the speaker flush with the ground as above, you instead lay the speaker enclosure on its side on the ground so that it is firing directly in parallel with the ground and then you place the mic right on the ground some distance away. Ideally you want the test site to be located well away from buildings or obstacles so that any reflections are a minimum. A good location might be a driveway or parking lot. When you perform a ground plane measurement you are measuring both the speaker and its mirror image. For the best high frequency results the mic should be placed within a fraction of an inch of the ground plane surface.

**Nearfield Measurement Indoors**

One of the most convenient ways to measure the low frequency response of a loudspeaker is by placing the microphone very close to the cone of the loudspeaker under test. This test is particularly suitable for measuring the response of woofer systems in closed boxes. Nearfield measurements are not as vulnerable to room reflections and resonances and can be conducted indoors with good results if some care is taken to place the speaker and mic well away from the room surfaces. The microphone is normally placed just a fraction of an inch from the cone of the speaker under test. Nearfield measurements are not appropriate for tweeters or multi-way loudspeaker systems.

Note that near field measurements are only accurate in the low frequency range of a driver. The table below shows the upper limit where the response in the near field has fallen by 1 dB. You might consider this to be the upper limit of accurate near field measurement. At even higher frequencies, there are a series of nulls in the near field frequency response and the near field response is no longer representative of the speaker in the far field. The approximate frequency of the first null is also given below for each driver diameter.

<table>
<thead>
<tr>
<th>Driver Nominal Diameter</th>
<th>Nearfield -1 dB Limit</th>
<th>First Nearfield Null</th>
</tr>
</thead>
<tbody>
<tr>
<td>18&quot;</td>
<td>460 Hz</td>
<td>1.8 kHz</td>
</tr>
<tr>
<td>15&quot;</td>
<td>580 Hz</td>
<td>2.3 kHz</td>
</tr>
<tr>
<td>12&quot;</td>
<td>700 Hz</td>
<td>2.7 kHz</td>
</tr>
<tr>
<td>10&quot;</td>
<td>900 Hz</td>
<td>3.4 kHz</td>
</tr>
<tr>
<td>8&quot;</td>
<td>1100 Hz</td>
<td>4.2 kHz</td>
</tr>
<tr>
<td>6.5&quot;</td>
<td>1300 Hz</td>
<td>5.2 kHz</td>
</tr>
<tr>
<td>5.25&quot;</td>
<td>1600 Hz</td>
<td>6.4 kHz</td>
</tr>
<tr>
<td>4.5&quot;</td>
<td>1800 Hz</td>
<td>7.2 kHz</td>
</tr>
<tr>
<td>3&quot;</td>
<td>2800 Hz</td>
<td>11.0 kHz</td>
</tr>
</tbody>
</table>
Measuring the Noise from Audio Equipment

To analyze the noise from an audio component (such as an equalizer) you do not need to use a test signal, just connect the output from the unit being tested to the PC’s line in jack. Set the analyzer frequency range and dB limits. You will want to be sure to set the lower dB limit well below the expected noise level. Before you can evaluate the noise of a unit under test you must first know the noise floor of the test system itself. Ideally the test system’s self noise would be much lower than the noise of the unit under test. As a reference, you can measure the noise floor of your PC sound system and save that in Memory 1 for comparison to the noise from the unit under test.

Once the unit under test is connected and powered up you can start the analyzer and the noise response will be displayed.

The noise from electronic gear will often have two main components. The first type of noise is hum and buzz, which can be traced to the AC power supply. Power supply hum appears as 60 Hz and harmonics of 60 Hz (120, 180, 240 Hz and so on). If you live in a region with 50 Hz electrical power service then expect 50 Hz noise and its harmonics. The second type of noise you will often see is broadband white noise that we hear as hiss. This is the basic background noise that occurs at all frequencies and has a response that rises with frequency.

If you are serious about noise testing then you can make a big improvement in your measurement capability by adding a low noise preamp between the output of the unit under test and the Line-In of the PC. The preamp will boost the test unit’s noise further above the noise floor of the PC and allow you to measure very low noise levels. The gain of the preamp must be known (say, 40 dB) and then you can subtract this gain (40 dB) from the measured noise response to obtain the equivalent noise level at the Line-In of the PC. Use the Shift utility to shift the measured response down by the appropriate dB level. This auxiliary preamp will allow you to do measurements down to a level determined by the preamps front-end noise.
Basic Questions about TrueRTA

Q: What is a Real Time Analyzer?

Back in the late 1970’s audio engineers started using Real Time Analyzers, or RTAs, to provide a live display showing the frequency spectrum of audio signals. These early analyzers worked by using a collection of electronic bandpass filters. Each band was typically one-octave wide and the bands were distributed on center frequencies spaced in one-octave intervals. The most popular octave center frequencies are: 62.5 Hz, 125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, 4 kHz, 8 kHz and 16 kHz. One full range audio signal was input to the bank of bandpass filters with the output of each filter representing the signal level for that frequency band. Then, the output of each filter would be fed into something equivalent to a VU meter, usually an LED display, to show the loudness of the signal in each frequency band. By placing the level displays side by side they formed a live graph of the audio signal and we were able to see the bass versus the treble energy, or perhaps a peak in the midrange…all in real time as the music played.

In those early days of RTAs the popular analyzers had an LED display with a bar graph that displayed 10 bars as an octave equalizer. Each bar was driven by the output of one of the bandpass filters. In search of better resolution, engineers then divided the frequency bands into even more narrow bands. From one-octave frequency bands we advanced to 1/3-octave bands, going from 10 bands to 30 bands across the audible spectrum. Today even finer bands are used for audio analysis.

More recently, digital technology has given us a new way to achieve the same results. Today, once we have a signal in the digital domain, such as a PC with a sound card, we can bring to bear the awesome power of Digital Signal Processing or DSP. Modern personal computers now have enough power to do a significant amount of processing of live audio signals.

By using powerful DSP methods, TrueRTA can show you 1/24th octave frequency bands for a total of about 240 bands spanning the full audio spectrum! The display is very smooth and reveals even the finest detail of the program material under analysis, whether it is music or a test tone.

Q: How might I use a Real Time Audio Analyzer?

There are a many uses for an audio spectrum analyzer. Here are just a few:

- Measure the frequency response of various types of audio equipment
- Analyze the distortion characteristics of audio equipment
- Study the noise characteristics of acoustic environments or electronic gear
- Professional audio recording, mixing and mastering
- Audio product design and production testing
- Voice and music learning aid
- Design and testing of musical instruments

Some of the above applications require the use of the analyzer in combination with a test signal from the generator. Others (such as noise analysis or analyzing live or recorded music) require no test signal.
Q: Besides TrueRTA, what else do I need to set up my own audio test lab?

- A digital voltmeter to calibrate TrueRTA™ for your sound card
- A collection of cables and adapters for connecting electronic gear to your sound card for testing. Note: Most PC sound system jacks are stereo, 1/8”, mini phone plugs.

If you want to do acoustic testing of loudspeakers in addition to the above you will need:

- A measurement microphone (with calibration file if available)
- A microphone preamplifier or mixer
- An audio power amplifier to drive the speaker under test
- Cables to connect the output of the sound card to the input of the audio power amp

Q: Could I put TrueRTA on my laptop and use it for real time analysis in my car? I have a sound blaster Extigy external sound card. It has microphone inputs and many others.

Sure! We have many TrueRTA users who get excellent results using laptop PC's with USB sound systems.

Q: What are the minimum system requirements? What speed of processor is required for all features, for example.

The MINIMUM system required to run TrueRTA is a PC with a 500MHz Pentium III processor and 64MB of RAM.

Q: How do you select the input signal for TrueRTA?

You have to use the Windows Record Mixer to select the input to TrueRTA. The signal selected for recording will be the signal that TrueRTA receives as its input. See "Getting Started Quickly" under the Help topics for details on opening the Record Mixer.
Registration Code Questions

Q: I have recently had occasion to resurrect my project using TrueRTA. Downloading the latest version, I entered the registration code but I still do not have resolution above 1 octave. Any ideas?

Your name, address, and other information are also a part of the registration code. Be sure to Copy and Paste the information exactly as sent in the email. Also, make sure that you do not add any extra "hidden" spaces when you copy the code, as that will invalidate the code.

Q: What happens if my hard drive crashes or the program is corrupted and I must reinstall it - will my activation codes still work?

No problem. Your original registration code will work fine. The product is not keyed to your hardware.

Q: Will I be able to transfer the unlocked software to a new system? I may need to do this if I buy a new laptop.

Yes you can easily transfer TrueRTA to your new PC. It will not be a problem.
Microphone Questions

Q: What Measurement Microphones and Mic Preamps are available and where can I purchase them?

While laboratory grade microphones and mic preamps are relatively easy to find, they can be quite expensive. Inexpensive measurement microphones and mic preamplifiers are more difficult to locate so we have made an attempt to locate a few products that can make it easier for audio hobbyists to set up an audio test lab.

Behringer ECM8000 Omnidirectional Measurement Microphone

This microphone is generally available at music stores for around $40.00. It is an electret condenser type and requires phantom power (+15 to +48 VDC) from the preamp in order to operate. You will need a mic preamp that supplies phantom power in order to use the mic with your computer sound system. Based on the frequency response curve provided with the microphone the response appears to be within plus-or-minus 1 dB from 20 to 20 kHz.

Behringer UB802 Microphone Mixer

The UB802 has two microphone input channels with switchable 48 VDC phantom power as required by the ECM8000 microphone above. This unit is generally available for about $69 in music stores.

Behringer MX602 Microphone Mixer

The MX602 has two microphone input channels with switchable 48 VDC phantom power as required by the ECM8000 microphone above. This older mixer is still generally available for about $69 in music stores. (compare to the UB802 above)

Behringer SHARK DSP110 Multi-Function Microphone Preamp

Behringer’s DSP110 preamp is available for about $69.00 at music stores. It provides the phantom powering required by the EMC8000 microphone (above). This unit is much more than just a preamp as it includes a number of digital processing functions. Even with all the extra functions this is still one of the least expensive mic preamps available. The DSP110 is also available from the above Internet sources. The biggest problem you might have with this unit is turning off all the special features!

Rolls MP13 Mini Mic Preamp

This is a very basic single channel preamp that can supply 36 VDC of phantom power to professional grade balanced microphones such as the ECM8000 above. It has both balanced and unbalanced input as well as balanced and unbalanced outputs. A single control varies the gain from 6 dB to 50 dB. A push button switch turns the phantom power on and off. It typically costs about $89 in music stores

Audio Buddy, Dual Mic Preamp

The Audio Buddy is a two-channel mic preamp that costs about $85.00. It provides phantom power but the voltage is not specified and may be only 9 VDC. This may or may not be adequate to power the EMC8000 mic as the mic specifies a range from 15 to 48 VDC. We mention this preamp here only because so few inexpensive products are available.
Here are links to some Internet sources for the above items:

Lentines Music: http://www.lentines.com

8th Street Music: http://www.8thstreet.com

Musicians Friend: http://www.musiciansfriend.com

Note that True Audio is not affiliated with any of the products or retail outlets mentioned above.

**Q: Where can I have a microphone calibrated?**

One source for microphone calibration services is Kim Girardin. Here is his information:

Kim Girardin  
Wadenhome Sound  
1400 Homer Rd. Suite 2  
Winona, MN, 55987, USA  

Phone: 507-454-8844  
E-mail: kmgrdn@luminet.net

**Q: Most sound cards have a microphone input. Can this replace an external mic preamp?**

For basic measurements the simple unbalanced mic input on the sound card can work fine. You will probably be limited to multimedia mics or a mic that you build yourself. Noise may become a problem with longer cable lengths.

If you are using a professional balanced microphone (like the Behringer ECM8000 we recommend above) you will need a mic preamp with balanced inputs and phantom power. This usually calls for the use of a professional mic mixer as the preamp and source for the phantom power.
Sound Card Questions

Q: I'm using an Audigy (or Audigy 2) sound card and am not getting a flat response in the self test. What is the problem?

The default setting of the Audigy mixer has the Line-In signal playing back through the Line-Out. This places the system in a hard wired feedback loop when you patch the Line-Out to the Line-In for testing purposes. Depending on the level settings, the system may oscillate or just give a bogus frequency response.

Fortunately the fix is quite simple. You just need to set the mixer so it does not route the Line-In signal to the Line-Out. The details are included in the Audigy setup file below:


Also, make sure you review the Quick Start in the TrueRTA Help Topics.

Q: I recently changed laptops, removed the old program from the old computer and installed the program on the new laptop. The program loads fine and opens fine. However, I now use an outboard D/A, A/D, audio In/out USB audio card. The program will not choose the device. Is there somewhere I can correct for this?

Make sure you have the outboard audio system selected as the DEFAULT audio input and output device at the "Audio" tab of the "Sounds and Audio Devices" Control Panel. TrueRTA always uses the default audio input and output devices.

Q: I'm considering the purchase of this product, as it will solve all my testing needs. My question is can I use a USB or firewire audio I/O device with this program so I can improve the audio quality over the sound card, or am I limited only to the laptop's on board sound card?

Yes, you can use USB or firewire based sound systems with TrueRTA. The software will use whichever sound system you have selected as your "default" sound system.
Calibration Questions

Q: Do I need to calibrate TrueRTA with the voltmeter if all I am using it for is the audio analyzer?

No. You only need to calibrate it if you are going to make voltage measurements where the absolute voltage or dBu level must be known. If you are only interested in relative measurements like "there is a peak of +6.25 dB at 500 Hz compared to the rest of the response" then voltage calibration is irrelevant.

If you do not calibrate TrueRTA then the actual Line-In and Line-Out levels will be unknown. When you set the generator output level to -10 dBu the actual output level may be considerably higher or lower. Similarly, an input signal that reads -10 dBu may actually be higher or lower in level.

Q: Assuming proper calibration, how accurate are the various measurements?

Using Quick Sweep you can measure frequency responses to within + or - .05 dB. For acoustical measurements the accuracy is typically limited by the accuracy of the microphone calibration. The stability of the AC signal calibration will vary depending on your sound hardware but is generally quite good.

Q: After clicking OK at the calibration dialog why can I no longer see any response?

Your TrueRTA is probably miscalibrated. The quick fix is to go to the Audio I/O menu and open the Line-Out and Line-In Calibration dialogs. At each of these dialogs click on the button labeled "Restore Default Calibration." That should fix the problem.
Other Technical Questions

Q: Is there any way I can save graphs in either jpeg or bmp format to send to others or review later?

You can take a "screen shot" by pressing the "Print Screen" key on your keyboard. This places the image of the screen on the clipboard. Then paste the image into your graphics application and save it in the format you wish.

Q: I have been looking to buy or rent a RTA analyzer to help me dial in my home theater system. Your software seems like it could do the trick for less. How accurate is it compared to other analyzers?

The software itself is extremely accurate. By far the largest sources of error will be the microphone and sound card. Fortunately TrueRTA provides calibration routines to remove the response of the sound card and accepts standard microphone calibration files to remove the response of the microphone from your measurements.

Q: Does TrueRTA's Quick Sweep have a gating function?

There is gating but it is sufficiently wide that it does not exclude room reflections on the acquired sweep. Because of the wide gate, room reflections will influence measurements when testing indoors. For this reason I recommend performing your most critical measurements outside in the open whenever possible. This is really the only way to remove the effect of the room from the measurements. Gated in-room measurements therefore are not particularly useful in the bass range...where the worst problems tend to occur. Measurements made outdoors in the open using Quick Sweep can be truly anechoic while retaining full low frequency resolution. Indoors Quick Sweep shows you the combination of the speaker response and the room influence...as you normally hear the combination. Taking the difference between the ground plane (half-space) response and the in-room response reveals the effect of the room.

Q: I'm thinking about purchasing the full package primarily for testing loudspeakers. Can I use it to measure a loudspeakers distortion?

You can use TrueRTA to very accurately measure loudspeaker frequency response and also evaluate the distortion performance of loudspeakers. For distortion testing you drive the speaker with a sine wave and directly read the levels of each distortion component in the measured spectrum. For example, a distortion component that is 20 dB below the level of the test tone constitutes 10% distortion. Here are some other levels and the corresponding distortion level:

<table>
<thead>
<tr>
<th>dB Below Test Tone</th>
<th>% Distortion</th>
</tr>
</thead>
<tbody>
<tr>
<td>-5 dB</td>
<td>56.2 %</td>
</tr>
<tr>
<td>-10 dB</td>
<td>31.6 %</td>
</tr>
<tr>
<td>-15 dB</td>
<td>17.8 %</td>
</tr>
<tr>
<td>-20 dB</td>
<td>10.0 %</td>
</tr>
<tr>
<td>-25 dB</td>
<td>5.62 %</td>
</tr>
<tr>
<td>-30 dB</td>
<td>3.16 %</td>
</tr>
</tbody>
</table>
Q: I am currently mainly interested in low frequency response and was hoping to use my RS sound pressure meter as a mic. Is this ok? If so, do you have the correction text file?

Yes, it should be fine. We don't have a correction file for the RS meter but I have seen them posted on the Internet. Note that with a laptop you will have to be careful not to overdrive the mic input. Make sure to first verify that you have a clean (not overdriven) signal at the scope before attempting any calibration routines. You may have to use a generator level down around -30 dBu with your notebook.

Q: What version do I need for car audio purposes?

You probably want at least 1/3 octave resolution. By far the most popular version is Level 4 with 1/24th octave resolution.

Q: What’s the difference between Pink Noise and White Noise?

There are two types of broadband noise test signals that are widely used for spectrum analysis: pink noise and white noise.

White noise sounds like the noise you hear when you dial between stations on the radio. It’s also commonly referred to as "hiss". White noise has equal amounts of energy for any given linear frequency band. There is as much energy in the range from 0 to 1 kHz as from 1 kHz to 2 kHz. When you look at white noise using an FFT analyzer you see a flat frequency response. That is, all frequencies appear at the same loudness across the spectrum. But if you view white noise with an RTA, the RTA shows the noise much more like our ears hear it. To our ears the white noise is hissy sounding with an emphasis on high frequencies and a lack of low frequencies. That is also how white noise appears on a RTA where it exhibits a 3 dB per octave rise with frequency.

Pink noise has equal energy per octave or fractional octave band. This means that a 1 octave wide band of pink noise centered around 100 Hz has the same energy (and loudness) as a 1
octave band centered around 1 kHz. The result is that pink noise appears flat when viewed on an RTA but appears to have a response that falls at 3 dB per octave when viewed on an FFT analyzer. To the ear, pink noise sounds “flat” with the lows and the highs sounding about equally loud. This closer match to what we hear is the reason audio engineers prefer to view live audio signals using an RTA or “constant fractional bandwidth” analyzer. Pink noise also provides for a more nearly constant signal to noise ratio when making audio measurements.
Troubleshooting Questions

Q: I am unable to get a response when I connect a microphone. It does not read any mic input on the PC I am using. Is it the sound card or what?

This sounds like an input signal selection problem. Make sure you select the input to TrueRTA at the Windows RECORD mixer. Here is how you do it: First, open your Playback Mixer by double-clicking on the volume control in the task bar, then go to the Options menu and select Properties. When the properties dialog comes up switch from "Adjusting the Volume for Playback" to "Adjusting the Volume for Recording." Click OK. Now, at the Record Mixer select the Mic input. The Mic input signal will now appear as the input to TrueRTA.

You might want to review the Quick Start topic in the on line help system. Once you are comfortable with operating the Play and Record mixers input selection will become routine.

Q: Why is the analyzer showing a signal even though there is no microphone attached? Mic has been selected in the windows recording volume control.

It is normal for any PC sound system to exhibit a broadband noise floor such as you describe. It is usually higher with the mic input because of the extra gain used at that input. Even the very best audio gear will exhibit broadband noise when analyzed this way. So the question becomes: What is the level of the noise?

Q: I seem to be getting feedback of some sort. Any ideas?

You may have the Windows Playback mixer set wrong. Open the Windows Playback mixer and make sure that you DO NOT have Line-In selected for playback. Only the WAVE signal should be selected at the Play mixer. (a hard wired feedback loop can be created if you are in loopback configuration with the Line-In signal is selected and fader raised...not good) This can cause a wide range of strange problems.
Application Note 1: Self Test of the PC Sound System

This note explains how to measure the frequency response of your PC’s sound system using pink noise as the test signal. The measurement includes the combination of the output signal path and the input signal path. This includes the A/D and D/A converters, and all output and input filters.

The Hardware Setup:

Setup your hardware by patching the Line Out jack directly back to the Line In jack. As most PC sound systems employ 3.5mm (1/8”) jacks you will need a patch cable with a 3.5mm plug on each end. Plug one end into the Line Out jack and then plug the other end into the Line In jack.

Output and Input Signal Selection

1) Open the Windows Volume Control:
   • From the task bar, right click on Volume and select “Open Volume Controls” or, from the Start button select: Programs/Accessories/Entertainment/Volume Control.
   • At the Windows Volume Control select the Wave output and set the Wave fader at maximum. Also set the Play Control (master volume) fader at maximum. This will set your output signal to precisely the level you have specified at the Signal Generator Dialog Bar.

2) Switch to the Recording Mixer:
   • From the Volume Control’s Options menu select Properties.
   • At the Properties window’s “Adjust volume for” section select “Recording”.
   • Click on the OK button to close the window to bring up the recording mixer.

3) Select the Line input:
   • At the Record Control mixer select Line In.
   • Raise the Line In volume slider to a reproducible setting and Exit the Recording Control.

Collect the Data Using Pink Noise

Launch TrueRTA and select the Spectrum Analyzer. Set the upper limit to +10 dB and the lower limit to –60 dB. Set the frequency extremes to 20 Hz and 20 kHz. At the Analyzer Bar enter 1000 (at the very bottom) as the number of averages to take. This will give us a display that updates slowly and represents a large number of averages. Averaging will reduce the peaks and dips normally seen on the pink noise response. The larger the average you use and the longer you let the analyzer run the smoother the pink noise response will be.

Select pink noise as your signal source and enter –10 dB for the amplitude at the Generator Bar. Because the pink noise has signal peaks higher than the nominal signal level it is somewhat easy to clip (overdrive) the noise and get a bogus response. So make sure you do not overdrive the pink noise by using too high an output level. You can check this at the scope by looking for clipped peaks in the noise waveform. If the peaks are clipped then drop the generator level until the noise is below the clipping level.
Start the RTA and then start the generator. You should see the frequency response of the sound system shaping up on the display. Let the analyzer run long enough to average out the response a bit and then stop the analyzer. Save the response to a memory and then save the project file.

**Other Things to Try**

Try changing the number of averages to 1, 10, 100 up to 100,000. Adjust the upper and lower dB limits to zoom in and see a high-resolution response. Print a copy of your PC’s sound system frequency response.

Try measuring the response with Quick Sweep. Notice the smooth, noise free measurement as opposed to the “noisy” response obtained with pink noise. Quick Sweep’s digital chirp allows measurements as precise as +/- 0.05 dB!
Application Note 2: Measuring and Voicing a Home Theater Sound System

About Film Theater Voicing

Using TrueRTA you can measure the frequency response of a loudspeaker system with great precision. Then, knowing the frequency response of the system and using readily available 1/3 octave equalizers you can reshape the frequency response of the system into any shape you wish. Now, with this powerful measurement and EQ capability what final frequency response do you actually want to achieve? The automatic response would seem to be “flat”, but upon close inspection the answer is not so simple and depends of what kind of sound system you are voicing.

If you are voicing a major cinema theater then the answer is the “X-Curve” as spelled out in the industry standards. The “X-Curve” is the official “house curve” of the film industry. For home theater applications the answer also appears to be the X-Curve, or at least the small room version of that curve. If the film you are watching in your home theater was mixed on monitors that were voiced using the x-curve then you will likely get the best results with an x-curve voiced loudspeaker system in your home theater.

The film industry has long seen a need to have their films sound the same from theater to theater. Also, films from different studios needed to have a similar overall sound. Some standard loudspeaker frequency response was needed that could be reproduced in each theater. The oldest standard curve dating back to the early years of cinema sound was called the “Academy Curve”. The academy curve was flat from 100 Hz to 1.6 kHz and fell rapidly beyond these limits. By the 1970’s the academy curve, with its limited frequency range, was in need of an update. In 1984 a new SMPTE standard was published after nine years of work to formalize the new standard for monitor voicing for the film industry. That new standard frequency response curve was named the “X-Curve” and is defined in the engineering standards ANSI-SMPTE 202M and ISO2969. The frequency response adopted for the new standard came as no surprise as this was the response most widely recommended (without the advantage of a formal standard!) for voicing concert halls and recording studios. The x-curve response is flat up to 2 kHz then falling 3 dB per octave to 10 kHz above which it falls at 6 dB per octave. At the low end the x-curve frequency response is flat down to 63 Hz below which it falls at a rate of 3 dB per octave.

You might wonder why the standard response has the treble and low bass rolled off instead of being flat. There are some fine points regarding the frequency responses of the direct versus the reflected sound in various sized rooms and how this affects the overall perceived sound of different sized rooms. But primarily the reduced treble response was needed was simply because the existing body of work was created on monitors with a reduced treble response. Playback of typical existing program material would appear to have excessive high frequency content on speakers that delivered a true flat acoustic response. (This should be no surprise as that material was prepared using treble deficient monitors!) Unfortunately, once a body of work was in place that had been created on non-flat loudspeakers that body of work became the basis for setting a voicing standard. So the voicing standard really just reflects the voicing embedded in the existing body of recordings. If those first loudspeakers had achieved a flat frequency response then perhaps today the standard loudspeaker frequency response for the film industry would be flat. By the film industry initiating production of sound for film using speakers that were deficient in treble the standard was cast without it even being realized. Today we are left to deal with this non-flat standard as more and more people set up home theaters with high performance sound systems to view films on DVD.

There is little doubt among audio engineers that the “correct” loudspeaker voicing for playback of sound recorded with a flat response microphone would be flat. There is no mysterious requirement for some special frequency response to make a simple test recording sound “natural”. Record a trumpet with a flat microphone and play it back with a flat speaker and the trumpet will sound correct. But if you make a complex recording using loudspeakers that are voiced to some non-flat response then the only way to hear...
back what was originally intended is to play the material on a system with the same non-flat response. This is where we find ourselves with the x-curve.

If we need to voice a music recording studio control room or a home hi-fi system the situation is only slightly different. We might not like the “standard acoustic response” used by the film industry…but at least they have a standard! Unlike the film industry the music recording industry has no official standard for the frequency response of our loudspeakers. You might argue that “flat response” has been the goal of the hi-fi industry even though it is one that is rarely achieved. So in the end studio monitors and, especially hi-fi speakers are all over the road when it comes to frequency response. In a perfect world all speakers would sound the same within the limits of their bandwidth and power handling. But if you actually compare speakers in any hi-fi shop you will hear a wide variation in frequency response. This wide variation in the voicing of hi-fi speakers reveals clearly the lack of any well accepted standard frequency response. If we actually voice a hi-fi loudspeaker system to be flat and then listen to songs from the existing body of recorded music, frequently that material will sound too bright because it was not created using flat monitors. If we could magically transform the existing body of film and recorded music then we could all agree to standardize on loudspeakers with flat response. But we are sort of “trapped” with the existing body of work. We have to live with the existing movies and records as they are. But there is nothing to keep us from establishing “flat” as the new standard to new work.

What can we do? Well our playback systems need to be flexible with respect to playback voicing. We would probably like to have available for instant recall the following system voicings:

1.) Acoustically Flat Response
2.) X-Curve, large room (-3 dB/octave above 2 kHz)
3.) X-Curve, small room (-1.5 dB/octave above 2 kHz)

When we watch films from DVD we probably want our speakers to use one of the x-curve voicings (small or large room) so that we hear the film soundtrack as it was intended to be heard by the film’s sound mixer. When we play older music recordings we may want to use x-curve voicing as well. For listening to newer music recordings we can try out the flat response, then if you think it sounds too bright, fall back to the small room x-curve. Strictly speaking, only the most recent recordings that were actually produced using flat acoustic response monitors should actually be played using acoustically flat loudspeakers. Nothing “bad” will happen if you play back a DVD with flat voiced speakers…but a system with too much treble will make you (or your guests!) say “ouch” quickly as you pump up the volume and can prevent you from reaching full theater sound levels. The x-curve simply allows you to hear the sound track as it was intended to be heard.

The future may bring media will actually carry information about the voicing used to produce the material so that our media players can invoke the same voicing upon playback. Meanwhile, by voicing our own home theater sound systems to the small room x-curve we can experience a more satisfying (less biting!) overall frequency response that is similar to what the film makers intended to be heard in the theater.

**Measuring the Home Theater Sound System**

I recommend collecting 10 to 20 measurements of the sound system in a tight cluster around the actual listening area. These 10 or so measurements should be stored in the TrueRTA memories. Then take a grand average of these responses and store the average in an unused memory. Use this average response to equalize the system to achieve the desired response.

In order to help create your equalizer settings you can switch the display to 1/3 octave resolution and then shift the 1/3rd octave response so that it is centered about 0 dBu. At this point you can just read each band of the analyzer and change its sign (plus to minus or minus to plus) to get the corrective EQ for that
frequency. For example, if the 1/3\textsuperscript{rd} octave measured response at 100 Hz is -2 dB then the corrective EQ is +2 dB at 100 Hz.

In order to make it easier to implement house curves TrueRTA allows you to load a house curve and have the inverse of that curve applied to your measurements. With a house curve loaded you simply adjust your EQ for a flat measured response and you will actually achieve the intended house curve.

Note that when you install TrueRTA a folder called House Curves is created in the TrueRTA folder. The file named “Small Room X-Curve.txt” is appropriate for compensating home theater sound systems and most music playback systems and smaller music performance sound systems. The file named “Large Room X-Curve.txt” is appropriate for voicing large film theaters and for voicing music sound systems in larger rooms.

Here is a step-by-step guide to measuring your sound system’s frequency response and using a 1/3\textsuperscript{rd} octave equalizer to implement any desired response.

**Step 1**: Launch TrueRTA and save the new empty project under an appropriate file name. Load any necessary mic calibration curve and finally load the desired house curve using the commands under the Audio I/O menu. If you are targeting a flat response then no house curve is necessary. The “House Curves” folder is located in your TrueRTA folder.

**Step 2**: Collect measurement data using either Quick Sweep or Pink Noise methods. Save each measured response to an empty memory location (Alt+1, Alt+2, etc., see the View menu) Step the mic about the listening area for each new measurement collecting a total of 10 or 20 measurements. If the responses are highly consistent then fewer are needed. Save the project file again to store all your measured data.

**Step 3**: Average the measured responses (see the Average command under the Utilities menu) saving the average response to a new memory location. Switch to 1/3\textsuperscript{rd} octave resolution and use the Shift utility to vertically shift the average response so that it is vertically centered about the 0 dBu horizontal grid line. This will keep your EQ adjustments minimal. Save the Project file once again to store this new average response.

**Step 4**: First Hide and then Show the memory containing the average so that the new shifted data is placed on the Workbench. (Showing a memory moves it to the Workbench.) Export the 1/3\textsuperscript{rd} octave data to a new .txt file using the Export command under the File menu. Hide TrueRTA and open this exported .txt file in Notepad and Print the file.

**Step 5**: Using the (0 dB centered) printout of your measured response adjust the 1/3\textsuperscript{rd} octave equalizer band-by-band to the negative of the measured response for that band. If 100 Hz measured -2.5 dB then set the EQ’s 100 Hz band to +2.5 dB to correct the response at that frequency. Once finished save your EQ setting to a memory location in the EQ (if available).

**Step 6**: Measure the response again looking for a flat response to confirm the corrective EQ.

Perform this procedure once for each voicing you want to have available for your system. If you move the speakers or rearrange the furniture you may want to recheck the response. Also see the **Audio I/O menu**.